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Warranty and Disclaimer
WARRANTY
AMIRIX Systems Inc., doing business under its trade name VEMCO, provides a one (1) year warranty period for the Product from date of shipment.

VEMCO warrants that on the date of shipment all Products manufactured by VEMCO are free from defects in material and workmanship under normal use and service. This warranty applies
to the components necessary for equipment upgrades, i.e. the VR1/VR2 to VR2W upgrade. With respect to transmitter products, while VEMCO is able to predict battery life with some
certainty, VEMCO cannot guarantee that these Products will remain functional while submerged for extended periods of time. This warranty does not apply to any equipment, materials or
design supplied by Buyer or a third party; re-battery services provided by VEMCO; Products for which VEMCO has not received payment; problems that results from: external causes such
as accident, abuse, misuse; servicing not authorized by VEMCO; usage not in accordance with Product instructions; failure to follow the Product instructions or failure to perform
preventative maintenance; usage of accessories, parts or components not supplied by VEMCO.

This warranty shall survive delivery only on the conditions and subject to the limitations set forth below.

NOTICE PERIODS

To receive a warranty remedy for a Product, Buyer must contact VEMCO'’s Customer Support Department during the warranty period to receive the Return Material Authorization (‘RMA”")
instructions. Each defective Product returned for warranty remedy must be shipped at the Buyer's expense according to the RMA instructions and must include reasonable proof that the
claimed defect is due to a matter embraced within the warranty set forth above and that such defect did not result from any act or omission of Buyer, including but not limited to any failure to
operate and maintain the Product in accordance with VEMCO'’s applicable written instructions.

REMEDY

VEMCO'’s liability, and the Buyer's exclusive remedy under this warranty, as to a defect in material or workmanship, is limited to the repair of such defect in the accessory, equipment or part
in which the defect appears or, at VEMCO's option, to the replacement of such accessory, equipment or part with a similar item free from defect. As to any item repaired by VEMCO or
furnished as a replacement by VEMCO, VEMCO'’s liability and the Buyer’s exclusive remedy to the repair or replacement of such item for any further defect in material or workmanship,
provided VEMCO receives written notice at Halifax, Nova Scotia, of such further defect from BUYER within ninety (90) days after the repaired or replaced item is shipped to BUYER and
provided that BUYER returns same to VEMCO as provided under “Notice Periods”.

RETURNED ITEMS

All repairs, replacements and corrections described above shall be performed by VEMCO at its plant at Halifax, Nova Scotia, or at such other place as may be mutually agreeable, and with
reasonable care and dispatch in order that the Product, accessory, equipment or part will not be kept out of service longer than necessary. Return to BUYER of a repaired, replacement, or
corrected accessory, equipment, part or Product shall be at VEMCO's expense. Title to and risk of loss of the Product, accessory, equipment, or part returned to VEMCO pursuant hereto
shall at all times remain with the BUYER, except that title to a returned accessory, equipment, part, or Product shall pass to VEMCO concurrently with shipment to BUYER of any item
furnished by VEMCO to BUYER as a replacement therefore. VEMCO shall have only such responsibility for any Product, accessory, equipment, or part owned by the BUYER and in the
possession of VEMCO as is chargeable by law to a bailee for hire, but shall not be chargeable for loss of use thereof.

WEAR AND TEAR
Normal wear and tear and the need for regular maintenance shall not constitute a defect under this warranty.

DISCLAIMER AND RELEASE

THE WARRANTIES, OBLIGATIONS AND LIABILITIES OF VEMCO AND THE REMEDIES OF BUYER SET FORTH HEREIN ARE EXCLUSIVE AND IN SUBSTITUTION FOR, AND BUYER
HEREBY WAIVES AND RENOUNCES, ALL OTHER WARRANTIES AND OBLIGATIONS OF VEMCO AND ANY ASSIGNEE OF VEMCO AND ALL RIGHTS, CLAIMS AND REMEDIES OF
BUYER AGAINST VEMCO, EXPRESS OR IMPLIED, ARISING BY LAW OR OTHERWISE, WITH RESPECT TO ANY NON-PERFORMANCE OR DEFECT IN THE PRODUCT OR IN ANY
OTHER THING DELIVERED UNDER THIS AGREEMENT, INCLUDING BUT NOT LIMITED TO:

(A)  ANY IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE;
(B)  ANY IMPLIED WARRANTY ARISING OUT OF COURSE OF PERFORMANCE, COURSE OF DEALING OR USAGE OF TRADE;
) ANY OBLIGATION, LIABILITY, CLAIM OR REMEDY IN TORT, WHETHER OR NOT ARISING FROM THE NEGLIGENCE OF VEMCO OR ANY ASSIGNEE OF VEMCO, ACTUAL

OR IMPUTED;

(D)  ANY OBLIGATION, LIABILITY, RIGHT, CLAIM, OR REMEDY FOR LOSS OF OR DAMAGE TO THE PRODUCT, FOR LOSS OF USE, REVENUE, OR PROFIT WITH RESPECT TO
THE PRODUCT; OR FOR ANY OTHER DIRECT, INCIDENTAL OR CONSEQUENTIAL DAMAGES; AND

(E) VEMCO MAKES NO REPRESENTATION THAT THE PRODUCT WILL NOT INFRINGE ANY PATENT OR OTHER RIGHTS OF ANY PERSON AND BUYER AGREES TO
INDEMNIFY VEMCO AND HOLD VEMCO HARMLESS FROM ANY AND ALL CLAIMS AND LIABILITIES WITH RESPECT TO SAME TOGETHER WITH ANY CLAIMS AND
LIABILITIES WITH RESPECT TO ANY INFRINGEMENT OF ANY PATENT OR OTHER RIGHTS OF ANY PERSON ARISING AS A RESULT OF BUYER'S PRODUCTS,
TECHNOLOGY, ACTIVITIES, OR OTHERWISE.

LICENSE AGREEMENT

VEMCO grants to the Buyer a limited, personal license, with no right to sub-license, to use the Intellectual Property (“IP") and Embedded Software in the manner set out in the
Documentation. The Embedded Software and IP are not sold to Buyer. All property rights, including Intellectual Property Rights, remain with VEMCO. Al rights related to the Embedded
Software not expressly licensed to the Buyer are reserved to VEMCO. BUYER shall not permit any person other than BUYER and its employees to use or make use of the Embedded
Software and/or IP. BUYER shall not, and shall not permit any third party to, modify, adapt, translate, reverse engineer, decompile, disassemble, or create derivative works based on the
Embedded Software and/or IP. This license is assigned to the Product with which you have acquired the Embedded Software and/or IP. If the Product purchased is a Transmitter product,
be advised that the license life is equal to the operational life.

EXPORT
Products and associated materials supplied or licensed hereunder may be subject to various export laws and regulations. It is the responsibility or BUYER to comply with such laws and
regulations.

NEGOTIATED AGREEMENT
Itis fully understood by the parties that the price of the Product and other mutual agreements of the parties set forth in this agreement were arrived at in consideration of this warranty,
SPECIFICALLY INCLUDING THE WAIVER, RELEASE AND RENUNCIATION BY BUYER SET FORTH ABOVE (DISCLAIMER AND RELEASE).

© (2011) AMIRIX Systems Inc. All rights reserved. The information contained herein includes information
which is confidential and proprietary to AMIRIX Systems Inc. and may not be used or disclosed without prior

written consent of AMIRIX Systems Inc.
DOC-4469-03
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INTRODUCTION
ABOUT VEMCO

VEMCO, a division of AMIRIX Systems Incorporated, is a leader in the design and manufacture of
oceanographic research tools and systems since 1979. Located in Halifax, Nova Scotia, VEMCO's product
line ranges from miniature acoustic transmitters and data loggers to large tracking, positioning, and
monitoring systems. Data communication methods include acoustic telemetry, radio modem and cellular
telephone modem.

Please contact us at:
VEMCO Division
AMIRIX Systems Inc.
211 Horseshoe Lake Drive
Halifax, Nova Scotia
Canada B3S 0B9

Phone: +1-902-450-1700
Fax: +1-902-450-1704
Web: www.vemco.com

SYSTEM OVERVIEW

The VRAP software is designed to work with the VEMCO Radio-linked Acoustic Positioning (VRAP) and
Cabled Acoustic Positioning (CAP) systems. The software is used on a computer connected to the
positioning system’s base station. The base station communicates with remote receivers through either
radios (VRAP) or RS485 cables (CAP). These remote receivers are referred to as buoys, although only the
VRAP system receivers are actually contained in a buoy. The CAP remote receivers (buoys) are actually
housed in a waterproof case.

The buoys (remote receivers) receive acoustic pulses from free running pingers and/or telemetry
transmitters in the area of the study. This received information is transmitted to the base station where the
position of each tag is calculated by the VRAP software based on the arrival times of the acoustic pulses.
The positions of the remote receivers and the tags are displayed on the computer screen and stored in a
database.
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SOFTWARE
SYSTEM REQUIREMENTS

VRAP is a Windows©98/Windows NT© based software application that can be executed on any IBM
compatible personal or mobile computer with the following configuration:

Minimum Pentium 3 Processor, 500MHz
Minimum 4 MB Video RAM

256 MB RAM

Minimum SVGA Monitor 256 Colour

CD drive for program installation

Three button mouse

One serial port for base station interface (required)

The default setup is saved in a configuration file every time the program is exited.

It is recommended that a backup power supply (UPS) be used with the computer to prevent damage to the
database due to power fluctuations or loss of power.

NOTE: The VRAP software was written for 1024x768 screen resolution and is best viewed at this
resolution. Any other setting will alter the appearance but not affect the performance of the
software.

SOFTWARE INSTALLATION

VRAP is a Windows©98/Windows NT®© application. VEMCO assumes customer familiarity with
Windows©98 terminology.

To install the VRAP software:

Step 1: Insert the Install compact disk (CD) into the CD drive.

Step 2: From the Start menu in Windows©98/Windows NT®©, select Run.
Step 3: Type D:\setup.exe (or E:\setup.exe if using drive E)

Step 4: Follow the on-screen instructions.

Running VRAP on Laptop Computers

When running the VRAP software on a laptop computer, a problem has been encountered related to the
Power Save function built into many modern laptops. When the Power Save function powers down the
computer, the com ports are often closed but are not automatically re-enabled when the laptop is
“awakened”. The VRAP software will not be able to communicate with the base station and an error
message will be displayed. The VRAP software must be restarted in order to re-enable the com port and
restore proper operation. To avoid this problem, disable any Power Save features on the laptop prior to
running the VRAP software.

Be careful to avoid power fluctuations or interruptions during a study.
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The VRAP software contains the following sub-menus:

File - create a new project, open a previously created project, or print the results.
Edit - copy the results to the clipboard, setup a project.
Window - arrange opened windows during a study or playback.
View - zoom the Chart window in or out, and view the distances between buoys.
Tools - calibrate various values, test communication with each buoy, and put buoys in low-power
mode.
Study - start and end a study, view a playback file, and create a new playback file.
Help - use the help file to view the Software section of this manual while running the VRAP
software.

FILE MENU

New
The New option in the File menu is used to setup a new project. Before setting up a new project, create a
new directory in the Projects directory (the Projects directory was created when the VRAP software was
installed). When the New option is selected, the Open window will appear to allow the new project to be
named. After the project is named and the Open button selected, the Project settings window (see Edit
menu section) will appear so the project may be setup.
It is STRONGLY suggested that the directory containing the project be backed-up on a daily basis.

Open

The Open selection in the File menu allows a previously saved project to be opened. A new study (see
Study menu section) can then be run with this project's setup.

Reopen

The Reopen feature of the File menu lists the last five projects that have been opened. One of these may be
selected from the list to be opened.

Close
An opened project may be closed by selecting the Close feature in the File menu.
Save As
The Save As option allows a project to be saved under a different name. This allows more than one project

to have the same settings without requiring the extra effort of setting up the new projects.

NOTE: The features discussed thus far apply to the project settings only and not to data received during a
study. Data is automatically saved during the study.
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Print
The Print option is only available when a study is being run or while a playback is being viewed. During
either of these conditions, any of the following may be selected to be printed: Chart window, Buoy Status
window, Tag Status window, Track History window, Waypoints.

The Chart window is a graphic, so printing it will open the TeeChart Print Preview window. The others
are text files and printing one of them will open the Print Setup window.

TeeChart Print Preview
Selecting Chart window from the list in the Print command will open the TeeChart Print Preview window
and allow a copy of the Chart window to be printed to a configured printer. If a printer has not been

configured using the Printer Setup button then the default printer will be used.

The Paper Orientation box in the TeeChart Print Preview window allows the orientation of the graph on
the paper to be selected. The choices are Portrait (8.5x11 inches) or Landscape (11x8.5 inches).

The margins in the TeeChart Print Preview window can be adjusted by selecting the desired percentage
from the appropriate boxes in the Margin box. The margins can be reset by selecting Reset Margins.
Selecting View Margins will show the location of the margins in the window with gray doted lines.
Print Setup

When a text window (Buoy status, Tag status, Track history, Waypoints, or Study notes) has been selected
to be printed, the Print Setup window will appear. Within this window, the printer can be selected and the
properties set for it, as well as selecting the paper size, source, and orientation.

Page setup
The Page Setup option in the File menu allows the paper to be setup for printing, and will open when
printing either the Buoy Status window, the Tag Status window, the Track History window, or the
Waypoints window. The Page Setup window will open to allow the paper size and source to be selected,
the orientation of the paper (either portrait or landscape) to be chosen, and the size of the margins to be set.

Exit

Use Exit to leave the program, or click on the small “x” in the top right corner of the VRAP window.
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EDIT MENU
Copy

The Copy command allows the information in a study or playback to be copied. The Chart window may be
copied as either a bitmap or a metafile. The other windows (Buoy status, Tag status, Track history, and
Waypoints) are copied to the Clipboard and may be pasted in a spread sheet, such as Excel or Quattro Pro.

Project settings

A project is the geographical setup of the buoys and the information pertaining to those buoys and to the
tags used in the area. After a project is setup, any number of studies may be run using the project's settings.

A project is setup within the Project settings window. There are three areas of a project that must be
attended to: the physical location, the buoys, and the tags (continuous and coded transmitters). Each of
these is contained on a separate "page" in the Project settings window and are accessed by selecting the
desired tab in the top left corner of the window. For example, click the second tab (marked “Buoys”) to
move to the Buoys page.

When the project is setup, click the OK button to exit the window and save the project setup. The project is
automatically saved every time the OK button is selected in the Product settings window.

Project

The Project page in the Project settings window is used to enter the base station information, the speed of
sound, the telemetry data profile, and the background image.

Base station

The Base Station is the metal box to which the computer and the antenna are both attached. The com port
on the computer to which the base station is connected must be identified in the Com port box. This is a
pull-down list (click the down arrow next to the box) which identifies the com ports (also referred to as
serial ports) on your computer.

The Radio retries value is the number of times radio communication will be attempted before a
communication failure will be identified. This does not apply for CAP systems and can be left at the
default value (3).

The Failure delay is the length of time, in seconds, the computer will wait after a communication failure
has been identified and before communication is attempted again. For example, if the Radio retries value
is 3, and the Failure delay is 30 seconds, then the software will try to communicate with a buoy three times
and then wait 30 seconds before tying to communicate again. This does not apply for CAP systems and
can be left at the default value (30).
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to be recorded between the base station and the buoy. When enabled, the VRAPLOG.txt file will be
created in the project directory to record all radio communications. This file can grow to 4M per day so
only use the feature for debugging radio communication.

Speed of sound

The speed of sound in water is either entered as a default value or is calibrated. The default value is set at
1500 meters per second, but can be over-written by entering the new value in the Default box. After the
buoys are setup in the water and the locations are entered in the software, the speed of sound can be
calibrated by the buoys. If the calibrated value is to be used, the Use calibrated speed box must be checked
(see picture above) otherwise the default value will be used. The process of calibrating the speed of sound
is explained in the Appendix.

Telemetry data profile

The time axis in the telemetry graph (see Displays section of manual) is selected by entering a time in the
Time axis range box in the format of hours:minutes:seconds. This will be the length of time shown on the
horizontal axis in the telemetry data graph.

The Force inverted data axis option is used to invert the vertical axis, putting the smaller values at the top
of the graph and the larger values at the bottom. This feature is automatically used if the data is given as
depth, putting deep data near the bottom of the graph and shallow data near the top. This only needs to be
forced (the box checked) if the data is not depth but you want the axis inverted.
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Background image

The background image may be imported into the software. This background will be seen in the Chart
window during a study, or a playback, and the buoy and tag locations will be plotted on it.

BITMAP CALIBRATION

There are a variety of methods available to calibrate a bitmap for use with the VRAP software program.
The common methods will be touched on in this section.

The bitmap must have north at its top for the latitude and longitude scaling to be
properly implemented.

An important step to calibrating the bitmap is in correctly positioning the calibration
points. An example is shown in the sketch to the right. The two points (shown as red
dots) were selected to allow maximum vertical and horizontal separation between the
points. This will give the best scaling possible.

Electronic Charts with a Navigation Program

A navigation program, such as Nobeltec or the terrestrial equivalent ArcView, can be used with
electronic charts of the project area. The charts must be purchased locally in addition to the
navigation software and typically cost $200. To produce a calibrated bitmap using a navigation
program, follow the steps outlined below.

1. Open the navigation software and load the chart containing the project area.

2. Find the project area on the chart and use the zoom feature to adjust the view of the project area to
the desired scale.

3. Place a mark/waypoint close to one of the top corners and record the latitude and longitude of that
point.

4. Place a mark/waypoint close to the opposite bottom corner from the previously selected top corner
and record the latitude and longitude of that point. For example, if the top left corner was
selected, then use the bottom right corner (see example above). It is very important to use
opposing corners of the bitmap.

5. Make a couple of extra marks/waypoints and record their latitude and longitude information.
These additional points will be used to check the calibration in the VRAP software.

6. Copy the screen by simultaneously pressing the Alt and Print Screen keys.

7. Paste the bitmap into a graphics program that works with bitmaps, such as Paint or Photoshop.

8. Make desired changes to the bitmap, if applicable, such as removing any unneeded notations that
clutter the project area.

9. Save the bitmap, making note of its name and location.

10. Enter the VRAP software and insert the background image for the project (see Preview in the
Background image section).

11. Calibrate the background image (see Background image in the Calibrations section of the
Appendix).
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Electronic Charts without a Navigation Program

Electronic charts of the project area can be purchased locally for a typical cost of $200. A simple
chart viewing program usually accompanies the chart files. To produce a calibrated bitmap using the
chart viewing program, follow the steps outlined below.

1.
2.

3.

11.

Open the viewing software and load the appropriate chart.

Find the project area on the chart and use the zoom feature to adjust the view of the project area to
the desired scale.

Select an identifiable point in one of the top corners and record the latitude and longitude of that
point and the point location (eg. edge of island, road, top of lake, etc.). The latitude and longitude
of the mouse position is generally shown at the bottom of the window.

Select an identifiable point in the opposite bottom corner from the previously selected top corner
and record the latitude and longitude of that point and the point location. For example, if a point
in the top left corner was selected, then use an identifiable point in the bottom right corner (see
example on previous page). It is very important to use opposing corners of the bitmap.

Select a couple of extra identifiable points and record their latitude and longitude information,
along with the location of the points. These additional points will be used to check the calibration
in the VRAP software.

Copy the screen by simultaneously pressing the Alt and Print Screen keys.

Paste the bitmap into a graphics program that works with bitmaps, such as Paint or Photoshop.
Make desired changes to the bitmap, if applicable, such as removing any unneeded notations that
clutter the project area.

Save the bitmap, making note of its name and location.

. Enter the VRAP software and insert the background image for the project (see Preview in the

Background image section).
Calibrate the background image (see Background image in the Calibrations section of the
Appendix).

Using a Differential GPS and an Electronic Aerial Photo

1.

2.

Select the desired area for the project on the electronic aerial photo. Be sure the area is in bitmap
format (file extension is .bmp) and that the size of the file is no more than two megabytes (2 MB).
Print the bitmap of the project area and select two identifiable points on the photo (eg. edge of
island, road, top of lake, etc.) in opposing corners. For example, if a point in the top left corner
was selected, then use an identifiable point in the bottom right corner (see example on previous
page). Itis very important to use opposing corners of the bitmap. These points will be used for
the calibration.

NOTE: The points selected on the aerial photo must be points that are easily identified on the

ground. Be aware that aerial photos may be a few years old and therefore subtle changes
may have occurred in the area.
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3. Travel to the first of the calibration points to measure and record the latitude and longitude
repeatedly for approximately 30 minutes. Discard any unrealistic data (latitude or longitude that
is greatly different from the other measurements) and average the remaining data. This averaged
point will be used in the VRAP software.

4. Repeat Step 3 for the other calibration point.

5. Identify a couple of additional points on the photo and record the latitude and longitude of these
points. These additional points will be used to check the calibration in the VRAP software and do
not need to be averaged as the calibration points were (see Step 3).

6. Enter the VRAP software and insert the background image for the project (see Preview in the
Background image section).

7. Calibrate the background image (see Background image in the Calibrations section of the
Appendix).

Using a Differential GPS without an Electronic Aerial Photo

This method is best used with a differential GPS device that will record points, download them to a
computer, and plot the points on the screen.

1. Use the differential GPS to record the general shape of the project area. For example, if the
project is to be conducted in a lake, record the GPS data while walking or boating around the
circumference of the lake.

2. Record two points in opposing corners of the project area. For example, if a point in the top left
corner was selected, then use a point in the bottom right corner (see example on previous page).
It is very important to use opposing corners of what will be the bitmap. At each calibration
point, measure and record the latitude and longitude repeatedly for approximately 30 minutes.
Discard any unrealistic data (latitude or longitude that is greatly different from the other
measurements) and average the remaining data. The averaged points will be used in the VRAP
software.

3. Select a couple of extra points and record their latitude and longitude information. These

additional points will be used to check the calibration in the VRAP software and do not need to be

averaged as the calibration points were.

Download the data and view it on the computer screen at the desired scale.

Copy the screen by simultaneously pressing the Alt and Print Screen keys.

Paste the screen into a graphics program that works with bitmaps, such as Paint or Photoshop.

Make desired changes to the bitmap, such as tracing the outline of the lake, adding reference

points, etc.

Save the bitmap, making note of its name and location.

Enter the VRAP software and insert the background image for the project (see Preview in the

Background image section).

10. Calibrate the background image (see Background image in the Calibrations section of the
Appendix).

No gk

© ®
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PREVIEW

The Preview page in the Background section of the Project page is used to select the background that
will be seen on the computer screen during a study or playback. Initially, there is nothing in the
Preview section, as shown below. If a bitmap is available of the study area, enter the file path in the
Image file box, or click the arrow to the left of the Image file box to browse for the file. The file must
be in bitmap (.bmp) form to be compatible with the VRAP program.

~Background image

After a file has been entered, it is previewed in the window, : :
Preview | GIS settings |

as shown in the Project settings window on the previous

page. The default width and height are set at 1000 meters. v Image file |
If latitude and longitude information is available for the
background site, the information is entered using the GIS Wwidth {1000

settings page. Otherwise, enter the width and height of the Height |_1 000
bitmap image in meters.

NOTE: Bitmap resolution should be approximately 200dpi. High resolution bitmaps will use
additional computer resources and may significantly slow down the system.

GIS SETTINGS

The details pertaining to the background selected in the Preview page are specified in the GIS settings
page (GIS is Geographical Information System). When initially selected, the page appears as the one
shown below. Selecting the arrow symbol to the left of Calibrate will open the Calibrate background
window to allow the exact points to be chosen on the bitmap and the corresponding latitude and
longitude to be entered (see Calibration section of Appendix for details).

After the background has been calibrated, the ~Backaround image
Reference Lat and Reference Long values appear Preview GIS settings |
in the respective boxes. These values refer to the

: —
top left corner of the background. o Calirate ReferenesLat |~

[v Enable GIS Reference Long ID_"_-_'

The Enable GIS must be selected (checkmark in

box) in order for the latitude and longitude Note:
information to be shown on the screen and stored |  * The reference lat is the latitude of the top left hand sids of
in the study file along with the X and Y values. the background image. The reference longitude i the

longitude af the top left hand zide.
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Buoys

The Buoys page in the Project settings window (shown below) is used to enter information pertaining
to the buoys. The left side of the page contains operating information necessary for the buoys while
the right side contains the information relevant to each buoy.

"™ Project settings M=

Project  Buoys IEDntinuausTagsl Coded Tagsl

add | Delete | Edt |

Scanning cycle delay [min)] |1|:| 5/M |Depth|5tatus |>< |“|’ |Lat |L|:|ng
Caliration rterval (i) |50 F121 100 BuoyC GOR5 -2245 44°31 588N 053°47 350w
IE_ 20 1.00 BuoyB |B36.3 |-406.7 | 44731 495'M | 0BT 4055/

22 1.00  Buopd 4136 -256.6  44731.571'M | 0B347.502%/

Pozitions o ghow

[v Connect buays with lines
[ Calibrate buoys

Ok Cancel | Help |

The buoy information is added by selecting the Add button and filling in the necessary information in
the Buoy setup window. A buoy is deleted from the list by selecting the desired buoy (Buoy 9121 is
selected below) and clicking the Delete button. Selecting a buoy and clicking the Edit button will
open the Buoy setup window to allow any changes to be made to that buoy's information.

Scanning cycle delay - the length of time, in minutes, the buoys will wait between scanning cycles.
This feature is used to conserve buoy battery life.

Calibration interval - the time, in minutes, between automatic buoy position calibrations. The time
value used depends on the conditions in which the buoys are operating. A calibration may be
forced before the specified time has elapsed. This may be done by selecting Buoys in the
Calibrate option of the Tools menu, or by clicking the Calibrate button in the Chart window.

Positions to show - The number of previous buoys positions (previous calibrations) to be displayed
on the Chart window is entered in the Position to show box.

Connect buoys with lines - Selecting the Connect buoys with lines option (checkmark in box) will
connect the buoys shown in the Chart window with three lines. This aids in identifying the study
area within the buoys.

Calibrate buoys - When the Calibrate buoys box has a checkmark in it, the buoys will be
automatically calibrated according to the time entered in the Calibration interval box. If the box is
not checked then the buoys will not be automatically calibrated and the Calibration interval value
shown is ignored. The buoys can still be calibrated manually (see Tools menu).

Buoy Setup window
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The Buoy Setup window (shown below) opens when either the Add button or Edit button is selected in
the Buoys page of the Project settings window. There are two sections within the setup window,

Buoy settings and Positional data.

The Buoy settings section of the window includes the —Buoy zetting
serial number (S/N) of the buoy, the depth of the oy |_912D Shatus |—_|EHDM -

hydrophone (in meters), and the status of the buoy. The

status indicates the assignment of that buoy. For example, | Desthimi]1.00
the buoy to be assigned as Buoy A will have Buoy A —Positional data
selected from the pull-down list (click on the down arrow |, 0o L atitude |DD+DD_DDD- ~

next to the Status box). The other status options are Buoy _ = .
B, Buoy C, and Idle. Idle is used if a buoy is setup inthe | ¥ 00 Longiude 000700 000" _

software but not used in the study.

LCancel | Help

The positional data of the buoy may be entered in the
applicable boxes if the information is known. If the information is not known, the Calibrate option
under the Tools menu can be used to find the position data and that data will automatically be entered
in the Buoy setup window.

Continuous Tags

The Continuous Tags page in the Project settings window is used to enter the information pertaining
to the different continuous tags. The word “tag” is used to refer to all acoustic transmitter types and is
derived from the term “fish tag”. The Search for tags on study start option determines when the
buoys will begin listening for the tags on the selected frequencies. If the option is selected
(checkmark in box) then the buoys will begin the scanning cycle of listening for tags as soon as the
study is begun. With the option disabled, the buoys will not begin a scanning cycle until the Search
for tags button in the Chart window is selected.

™ Project zettings _ O[]

F'ru:uiectl Buoys ContinuousT ags |E|:n:|eu:| Tagsl

v Search for tags on study start &dd | Delete | Edit |
|:'IT'IEIETSI One channel I Twio channel I
Enabled| Freqg |S£N |Depth |Blanking| Period | Scan time| Scan dela_lrll Sample| Position alg |F'ulses {a] avg| T ail Iengthl
[v 500 2512 1.00 800 1000 12 0 20 Time average 80 100
[~ SINN #5173 1.00 300 1000 12 0 20 Time average 80 100
[H]# Cancel | Help

A continuous tag is added by first selecting the tab with the desired tag type listed (either pinger, one
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channel, or two channel), then clicking the Add button, and finally entering the necessary information
in the tag setup window. A continuous tag is deleted from the list by selecting the desired tag (click
on it with the mouse) and clicking the Delete button. Selecting a tag and clicking the Edit button will
open the setup window for that tag to allow any changes to be made to the tag's information.

The information pertaining to each tag is listed in the table for that tag type. A tag will only be used
in a study (searched for during a scanning cycle) if the Enabled box contains a check mark. Clicking
the box with the mouse button will toggle the Enabled option on and off.

Continuous Tag Setup windows

When a tag's information is added or edited (see Tags setup window), a setup window will appear
according to the tag type selected. This window will always contain the sections Tag parameters,
Scan options, Visual settings, and Calculation settings. Telemetry tags will also have a Telemetry
data section. A sample One channel telemetry setup window is shown below.

Tag parameters:

The Tag parameters include the operating frequency of the continuous tag (in kHz), the
approximate depth at which the tag is operating (only necessary if the tag does not transmit
depth telemetry data), the blanking interval (Blanking), and the serial number of the tag.

Two channel continuous telemetry tags also require the sync value (in milliseconds) used to
correctly identify the temperature and depth data. If this value is incorrect, the software will be
unable to identify the telemetry data from the received pulses. The sync value is usually
1150ms, but should be verified in the Transmitter Specifications manual shipped with the tags.

Scan options:

The Enabled check box is used to include this tag in the scanning cycle search. Tags can
also be enabled from the Continuous Tags page in the Project settings window.

The Scan time is the length of time (in seconds) that the buoys will listen for this tag on this
frequency. A Scan time of 12 seconds is suggested for continuous tags.

The Scan delay is the length time (in seconds) that the buoys will skip over this tag in the
scanning cycle. For example, if the Scan delay is set for 300 seconds (5 minutes) then the
buoys will not listen for this tag each time it appears in the scanning cycle for five minutes.
This is advantageous when using fixed marker tags.

The Upload interval is the time (in seconds) between data uploads from the buoy to the base
station during the Scan time. For example, if the Upload interval is set for 10 seconds and
the Scan time is 60 seconds, the buoys will listen for 10 seconds, upload the data, listen for
10 seconds, upload the data, and repeat the cycle of listening and uploading until the 60
seconds have elapsed. The Upload interval should not exceed 5 minutes.
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NOTE: When a buoy is uploading data to the base station it can not listen for acoustic tags.

During the Upload interval, the buoys with firmware versions 1.16 and higher are in Power
Saving mode and the radios on the buoys are off. This means that the base station radio can
not communicate with the buoys until the Upload interval is complete. This extends the time
between buoys battery charges.

Visual settings:

The tag colour can be changed by clicking on the down arrow next to the current colour (blue
in the example below) and either selecting a colour from those shown or selecting Other and
adding a different colour.

The Tail length refers to the number of previous points that will remain in the Chart window.
After the number of previous points has been met, the most recent points will remain and the
oldest point will be removed from the screen. For example, if the Tail length was set to five

points, when the sixth point is received it will be plotted on the screen and the first point will
be removed.

™ One channel telemetry zetup !E[

T ag parameter —Scan ophion

Frequency IW Enabled v
Depth IW Scan time [sec) IED—
Blanking IW Scan delay(sec) ID—
5/M Iw Upload interval [zec) I'IE—

—Wizual zetting —LCalculation setting

Colar Algarithm IF':::sit el averagej

-
T ail length |5 Pulzes to avg [3] IEEI

T elemety data
Channel 1 |

Sensor type IDEDth [ri) j

Slope IE-EVI ki period [me) I1 o0
Intercept I'-I 2.91 tax periad [mz] I1 50

Cancel | Help
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Calculation settings:

The algorithm used to calculate the position of a tag may be selected from the three given in
the pull-down list, namely Fast track, Time average, and Position average.

The VRAP software performs a statistical analysis to the received data and identifies the best
data. The Pulses to avg value is the percentage of data to be considered as “best” data and be
used in the algorithms. This value does not need to be set at the same value for all tags.

Telemetry data:

The Telemetry data section is only visible if the continuous tag type has telemetry
capabilities. Two channel telemetry will have two “pages” in this section, one with a tab
marked Channel 1 and a second tab marked Channel 2. A one channel continuous telemetry
tag setup will only have the Channel 1 page. Both channels require the same information in
order to correctly report the telemetry data.

The sensor type can be either temperature (in Celsius) or depth (in meters). Select the desired
sensor type from the pull-down list. The slope (m/s), intercept (m), minimum period (ms),
and maximum period (ms) values are mandatory for the software to correctly interpret the
telemetry data. The values are all listed in the Transmitter Specifications manual that was
shipped with the tags. The slope and intercept are found in the table at the beginning of
Transmitter Specifications manual. The minimum period and maximum period are taken
from the graphs at the back of the Transmitter Specifications manual by following the steps
listed below.

Min/Max Period:

1. Identify the correct graph for the transmitter. The transmitter serial number is listed
below the graph.

2. Calculate the minimum period value:

a. Read the minimum period from the graph. This will be the left end of the graph line.
The graph below identifies this point and gives a minimum period of 1.13 seconds.

b. Convert the period from seconds to milliseconds by multiplying it by 1000. In the
example below, the minimum period of 1.13 seconds becomes 1130 milliseconds
(ms).

c. Subtract 100ms from the minimum period read from the graph and round the value to
the nearest hundred milliseconds. The example’s value of 1130 ms becomes 1000 ms.
This is the minimum period value.

Enter the minimum period value in the “Min period (ms)” box in the tag setup window.

4. Calculate the maximum period value:

a. Read the maximum period from the graph. This will be the right end of the graph
line. The graph below identifies this point and gives a maximum period of 1.72
seconds.

b. Convert the period from seconds to milliseconds by multiplying it by 1000. In the
example below, the maximum period of 1.72 seconds becomes 1720 milliseconds (ms).

c. Add 100ms from the maximum period read from the graph and round the value to the

w
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nearest hundred milliseconds. The example’s value of 1720 ms becomes 1800 ms.
This is the maximum period value.
5. Enter the maximum period value in the “Max period (ms)” box in the tag setup window.

200
180
160
140
120
100

ani ~

B0
40
20

Coded Tags

The Coded Tags page in the Project settings window is used to enter the frequency and
information pertaining to the different coded tags to be used with the buoys. The word “tag” is
used to refer to all acoustic transmitter types and is derived from the term “fish tag”. A coded tag
uses a group of pulses to transmit an identification code (ID code) on a set frequency. This
allows a large number of coded tags to be used on the same frequency. There are also different
types of coded tags. The differences are explained in the Coded Channels section of the
Appendix.

When the Coded Tags page is initially opened, there are no frequencies setup. To add a
frequency, select the Add button in the top right corner of the Coded Tags page. This will open
the Coded 200 Frequency Setup window, shown here. Enter the frequency, Upload time, Scan
time, and Scan delay (these are explained below). Be sure the Frequency enabled box is
checked, otherwise this frequency will be skipped over during a study.

"= Coded 200 Frequency Setup M=l E3

Frequency EA.0 Scan time |5n
Ipload time IED— Scan delay Il:l—

W Frequency enabled

(] 8 Cancel | Help |
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The Scan time is the length of time (in seconds) that the buoys will listen for tags on this
frequency. A Scan time of 60 seconds is suggested for coded tags if a number of frequencies are
in the scanning cycle list. If only coded tags are being used and the tags are all on one frequency,
then a larger Scan time is suggested, such as an hour.

The Scan delay is the length time (in seconds) that the buoys will skip over this tag in the
scanning cycle. For example, if the Scan delay is set for 300 seconds (5 minutes) then the buoys
will not listen for this tag each time it appears in the scanning cycle for five minutes. This is
advantageous when using fixed marker tags.

The Upload interval is the time (in seconds) between data uploads from the buoy to the base
station during the Scan time. For example, if the Upload interval is set for 20 seconds and the
Scan time is 80 seconds, the buoys will listen for 20 seconds, upload the data, listen for 20
seconds, upload the data, and repeat the cycle of listening and uploading until the 80 seconds
have elapsed. The Upload interval for coded tags should be at least the same length of time as
the maximum off time for the tag (listed in the Transmitter Specifications manual).

NOTE: When a buoy is uploading data to the base station it can not listen for acoustic tags.

During the Upload interval, the buoys with firmware versions 1.16 and higher are in Power
Saving mode and the radios on the buoys are off. This means that the base station radio can not
communicate with the buoys until the Upload interval is complete. This feature extends the time
available between buoys battery charges.

After the frequency has been setup, select the OK button on the Coded 200 Frequency Setup
window and the new frequency will be added to the Project settings window with the Default
“D” coded map settings (see the Appendix for details) for the coded channels. The values
entered in the Coded 200 Frequency Setup window will be displayed at the top of the frequency
page but will not be directly accessible for editing.

A frequency can be edited by selecting the frequency tab (69.0kHz is selected in the window
below) and then clicking the Edit button in the top right corner. The Coded 200 Frequency Setup
window will re-open and allow changes to be made to everything in the window except the
frequency.

A frequency can also be deleted by selecting the frequency tab (69.0kHz is selected in the
window below) and then clicking the Delete button in the top right corner. A warning will
appear indicating that all transmitters setup on that frequency will be deleted if the frequency is
deleted. The frequency will not be deleted unless the Yes button is selected.

VEMCO - VRAP5 SOFTWARE MANUAL - PAGE 17



™= Project zettings [_ (O]
F'ru:uieu:tl Buu:u_l,lsl ContinuousTag:  Coded Tage |

add | Deke | Eat |

630|500 |

¥ | Erequencieratled Scan time IEEI Lpload time ||3|:| Szan delay IIZI

Channel A I Channel B | Channel C | Channel D |
~Charnel Settings o] Depth |F'-:usiti|:|n Alg |F'u|ses ko .-f‘-.vg|TaiI Lergth |

Code Type  [256 Pinger 7] 100 Position avera 0 100
aync (ms] |4D1-22 1.00 Pasition avera 80 100
Bir [mnz] |22_3 it 1.00 Puozition avera 80 100

—Default ID Settings————— 1.00 Position avera 280 100
Default Depthim] |1.0 an 1.00 Position avera B0 100
Diefault Colar - | 1.00 Position avera 20 100
v Plat unknown ID codes
add | Delete | Edt |

ak. Cancel Help

After a frequency has been entered, any tags received on that frequency will be detected and
identified by their ID code if they conform to the default coded channel setup. For custom tags
with sync and bin values that are not the default values, the coded channels (A, B, C, and D)
must be setup to match the tags. This is done in the Channel Settings section of the frequency

page.
Channel Settings:

The Channel Settings section includes the Code Type, the Sync value (in milliseconds), and
the Bin value (in milliseconds). These three settings must match the settings of the tag for the
tag to be correctly identified by the receivers on the buoys. The tag settings are found in the
Transmitter Specifications manual included with the tags when they are shipped from the
factory.

The Code Type can be changed by selecting another option from the pull-down list. The

differences between the code types is explained in the Coded Transmitter Types section of
the Appendix. The sync and bin values may be entered in the boxes marked Sync and Bin.
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If another type of coded receiver is being used with the study, such as a VR60, it is suggested
that the different receivers be setup with the same channel setup. For example, the setup for
Channel A on the buoys should match the setup of Channel A on the VRG60, the setup for
Channel B on the buoys should match the setup of Channel B on the VR60, and so forth.

Default ID Settings:

The Default ID Settings section of the frequency page is used to set the approximate depth
value needed for position calculations (unless the tag measures depth) and the default colour
which will represent tags received on this frequency in the Chart window.

The Plot unknown ID codes option will allow all received ID codes to be displayed in the
Chart window. Disabling this feature (removing the check mark) will allow only tags that
have been setup, and therefore are “known” to the program, to be shown in the Chart
window. All received ID codes will be stored in memory, but only tags that were setup will
be displayed.

A tag can be added to, deleted from, or edited in a frequency by selecting the appropriate button
at the bottom left corner of that frequency page. When the Add or Edit buttons are selected, a
window will open to allow the addition or changes to be made. This window is discussed in the
Coded Tag Setup Windows section. When the Delete button is selected, the highlighted tag in the
list on the right side of the window will be deleted. There is no warning window or undelete
feature so be sure the desired tag is the one highlighted.

For studies with large numbers of coded tags, it is suggested that the individual tags not be added
to the software. The buoys will identify any tags with the same Channel Settings information
and be able to do so faster than if each individual tag had been setup. For smaller studies where
each tag is to be identified with a unique colour, the tags will have to be setup. Also, telemetry
tags must be setup for correct interpretation of the data. In the example window on the previous
page, the tags with ID codes 76, 77, 78, 79, 80, and 81 have been setup with unique colours. Any
additional tags received on this frequency and code type will be shown in the default colour, red.
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Coded Tag Setup Windows

When a coded tag's information is added or edited, a setup window will appear according to the
tag type selected. This window will always contain the sections Tag parameters, Visual
settings, and Calculation settings. Telemetry tags will also have a Telemetry settings section. A
sample Coded 256 Sensor setup window is shown below.

"™ Coded 256 Sensor setup M[=] E3

— T ag parameter
]

Depth [m)

—

Calculation zethng

Algarithm IF':::Sitiu:un average

Fositions to awg [&]

=~

-

—Wizual zetting

Telemety zetting

Default Color -|'| S enar I[jepth [m] j
Tail length |5'J |_
Slope |1-532 Intercept |-15.82
0K Cancel | Help |

Tag parameters:

The Tag parameters include the ID code and the approximate depth at which the tag is
operating (only necessary if the tag does not transmit depth telemetry data). If the tag is
being edited, the ID code number is disabled and therefore not available for changes. When a
group of pingers (without telemetry) are being added with the same code type, sync, and bin,
the ID numbers may be entered as a range or group. In the
example shown below, the pingers with ID codes 5, 6, 7, 8, 9,

Tag parameter

10, 12, and 18 are entered at one time. Two dots between two | '° Fiands [5. 101218
numbers will add all numbers between the two (eg. 5..10). A Depth [m] 1.00

comma between two numbers will add both numbers but no
numbers between them (eg. 12,18).

Visual settings:

The tag colour can be changed by clicking on the down arrow next to the current colour
(green in the example above) and either selecting a colour from those shown or selecting
Other and adding a different colour.

The Tail length refers to the number of previous points that will remain in the Chart window.
After the number of previous points has been met, the most recent points will remain and the
oldest point will be removed from the screen. For example, if the Tail length was set to five

points then when the sixth point is received it will be plotted on the screen and the first point
will be removed.
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Calculation settings:

The algorithm used to calculate the position of a tag may be selected from the three
given in the pull-down list, namely Fast track, Time average, and Position average.

The VRAP software performs a statistical analysis to the received data and identifies
the best data. The Pulses to avg value is the percentage of data to be considered as
“best” data and be used in the algorithms. This value does not need to be set at the
same value for all tags.

Telemetry settings:

The Telemetry settings section is only visible if the 256 Sensor tag type is selected,
which has telemetry capabilities.

The sensor type can be either temperature (in Celsius) or depth (in meters). Select the
desired sensor type from the pull-down list. The slope (m/s or °C/s) and intercept (m
or °C) values are all listed in the Transmitter Specifications manual that was shipped
with the tags. These values are mandatory for the software to correctly interpret the
telemetry data.

WINDOW MENU

When a study or playback is in operation, a list of the opened windows is shown at the bottom of
the Window menu (below the double line). Selecting one of these windows from the list will
make that window the active window and bring it to the front if it is covered or restore it if it has
been minimized.

Tile

The Tile command in the Window menu will arrange the windows open during a study or a
playback so they are all visible. The active window at the time the Tile command was given will
be positioned in the top left corner of the VRAP window. This method of viewing the windows
works best with a large computer screen.

Cascade
The Cascade command in the Window menu will arrange the windows open during a study or a
playback so they are all stacked on top of each other with only the title bar visible on the lower

windows. The active window at the time the Cascade command was given will be positioned on
the top of the stack.
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Arrange lcons

The Arrange Icons feature will arrange the icons of any minimized windows in the bottom left
corner of the VRAP window. A window must be minimized before the Arrange lcon command
will have any effect on it. The icon closest to the bottom left corner at the time the command
was given will be the first in the corner, and so on. If the VRAP window is not wide enough to
accommodate all the icons then they will be stacked.

VIEW MENU

Zoom In

the image (pan) so the area of interest is in the center of the Chart window before

clicking the Zoom In feature. The Zoom In feature can be accessed either in the View

menu or by clicking the button with the magnifying glass and the plus symbol on it in the Chart
window.

The Zoom In feature allows the image in the Chart window to be zoomed in. Position
-I-|

Zoom Out

Zoom QOut feature can be accessed either in the View menu or by clicking the button with

The Zoom Out feature allows the image in the Chart window to be zoomed out. The |
the magnifying glass and the negative symbol on it (shown below) in the Chart window.

Buoy Distances

Buoy distances

The Buoy Distances option in the View menu will open the Buoys
distances window (shown below) to display the last known distances
between each pair of buoys. The buoys are identified by their serial
number and the distances are given in meters.

From To Digtance

9122 9120 19234483
9122 9121 19566820
9120 9121 19387545

TOOLS MENU
Calibrate
There are a number of aspects of the VRAP system that can be calibrated and can be accessed
from the Tools menu. These include: Buoys, Speed of sound, and Background image. Each of
these can also be accessed from different locations within the software.
Buoys
The Buoys command in the Calibrate section of the Tools menu will open the Chart window

without beginning a study (the Search for tags and Stop searching for tags buttons are not
present). Clicking the Calibrate buoys button in the top left corner will begin the process of
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calibrating the positions of the buoys. The Buoy status window will also open. A more in depth
explanation is given in the Calibrations section of the Appendix.

Speed of sound

The exact speed of sound in water is actually a function of the salinity of the water, and may be
calibrated for the project area by using the buoys. This calibration may also be accessed from the
Project page of the Project settings window (see Edit menu). The necessary steps are listed in
the Calibration section of the Appendix.

Background image

The background image shown in the Chart window (during a study) or Playback window (during
a playback) can be tied to the actual latitude and longitude values. How the background image is
calibrated is detailed in the Calibrations section of the Appendix.

Test communications

The Test communications option in the Tools menu will open the Buoy communication test
window. Communication between the base station and each buoy can be tested individually.
Select the desired buoy from the pull-down list in the Buoy to test box. Click the Test button on
the right side of the window. The bottom of the window is the status line and the events during
the communication test will be shown there.

After the communication test is completed, the battery

voltage (in Volts) and the time of the last roll over (in

hours) will be shown in the Communication results Buoy totest [3122 = Test
section of the window. A counter within the program Communication results— Close
will rollover every time the buoy is reset (powered up) Battery voltage  12.4 —_—
and every 15.5 hours after power up. The Last rollover Last rollover 095714 Help

is the time the counter last rolled over. This information
has trouble shooting benefits.

\Buoy 9122 replied. A

Sleep

The Sleep command in the Tools menu will put the buoys in a low power mode (or "sleep”
mode) to conserve the battery life of the buoys while they are not in use.

To power up a buoy after it has been put in sleep mode, send any command to that buoy. The
simplest method is probably to test the communication of the buoy.

NOTE: Due to improvements to the buoy firmware, the buoy radios drain less power from the

batteries while they are running than while they are in sleep mode. Plans are in place
for future improvements to sleep mode so it will drain less power than it presently does.
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STUDY MENU
Start

The Start command in the Study menu will begin a study. Six windows will open to display the
information collected during the study. These windows are titled: Chart window, Buoy status,
Tag status, Track history, Waypoints, and Study notes. The windows will appear in the same
manner they appeared when the last study was ended. For example, if a window was minimized
when the previous study was ended, then that window will be minimized when the new study is
begun. The window locations may be arranged using the options available in the Window menu.

The data received during a study is automatically saved in a data base as the study progresses.
The data base is in the same directory as the project file. This directory should be backed up
regularly. For large studies over a number of days, the directory should be backed up daily.

A study is ended by selecting the Stop study command, or by clicking the "X" in the top right
corner of the Chart window.

Stop study

The Stop study command (in the Study menu) is given to end the current study, which was begun
using the Start command. Clicking the "X" in the top right corner of the Chart window will also
end a study.

Playback

The Playback command, within the Study menu, allows a previous study to be viewed again by
replaying the plot file. Six windows will open to display the information collected during the
study. These windows are titled: Study playback, Buoy status, Tag status, Track history,
Waypoints, and Playback. The windows will appear in the same manner they appeared when the
last playback or study was ended. For example, if a window was minimized when the last
playback or study was ended, then that window will be minimized when a new playback is
begun. The window locations may be arranged using the options available in the Window menu.

When Playback is selected, the Open window will appear to allow the desired plot file to be
chosen. The plot files are named according to the date and order in which they were created (see
Plot file naming convention section).

HINT: Use the Pause feature (see Playback window section) to pause the playback while
analysing data that is time sensitive.

A playback is ended by selecting the Stop playback command, or by clicking the "X" in the top
right corner of the Study playback window.
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Stop playback

The Stop playback command, within the Study menu, is given to end the current playback of a
study, which was begun using the Playback command. Clicking the "X" in the top right corner
of the Study playback window will also end the playback of a study.

Build plot file

The information received during a study is stored in a data base and a plot file is created based on
the settings used during the study. The Build plot file command, within the Study menu, allows a
new plot file to be created from previous study data. A plot file was created during the study
based on the settings at the time of the study. Other plot files can be created using different
settings than those in the original study, and/or for a specific time period within the study.

"™ Create plot file I [=]

v Usze custom calculation settings

—Custom gettings
[¥ |gnore buoy recalibrations

[ Use 1500.0 ms for speed of sound

[T Use Position average = [for tag positions
[T Usethe best 100 2% of data for positions
[T Settagtallengthte 100 positions

[T Show 100 previous buoy positions

[+ Coded detection threshold Medium =

—Plat file time period
Stat | 5/29/02 7] [11:1%324M =
End | 5/29/02 =] | 1:52:02 PM =

[fGeremie | ooee | Hep

Plot file naming convention
Plot files are named using the convention VRAP YYYY-MM-DD.ZZZ, where:

YYYY-MM-DD
777

date the plot file was created (year month day)
number of plot files created on this date (beginning with 000)

An example of a plot file name is VRAP 2002-05-14.001, which is the second time a plot file
was created on May 14, 2002. The third plot file created on the same day would be VRAP 2002-
05-14.002. The file extension on the plot file increments by one each time a new plot is created
as long as all plot files are created in the same directory location.
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NOTE: By default, the Plot file time period covers all completed studies in a project.

To create a new plot file:

1. Select Build plot file in the Study menu.

2. Select the project file (with a ".vrp™ extension) in the Open window and click the Open
button. The Create plot file window will open.

3. To make a subset plot file with the original settings, enter the start and end times (with the
correct dates) in the Plot file time period section of the window. The Use custom
calculations settings box should be empty (no checkmark). Click the Generate button.

4. To make a plot file using different settings, click the Use custom calculations settings box.
Make the desired changes within the Custom settings section (these are explained below).
The box to the left of the desired change must contain a check mark for the change to
occur. If a subset plot file is also desired, enter the start and end times (with the correct
dates) in the Playback file time period section of the window. Click the Generate button.

5. View the new plot file by selecting Playback in the Study menu and selecting the new plot
file within the Open window.

Custom settings options:

NOTE: A change will only occur if the box associated with that change contains a check mark.

Ignore buoy recalibrations: New playback file will use the data based on only the initial
positions of the buoys, before buoy calibrations we made in the study.

Use _ m/s for speed of sound: Enter a new speed of sound to be used to calculate the position
of a tag (must click on the value currently shown before new value can be entered).

Use (pull-down list) for tag positions: Select the algorithm that is to be used to plot the tag
positions from the pull down list. The options are: Fast track, Time average, and Position
average.

Use the best % of data for positions: The VRAP software performs a statistical analysis to
the received data and identifies the best data. Enter the new percentage of this best data to
be used in the positioning algorithm (Fast track, Time average, and Position average).
This feature is referred to as Pulses to Avg in the transmitter setup sections.

Set tag tail length to ___ positions: The tail length refers to the number of previous points that
will remain in the Playback window. After the number of previous points has been met the
most recent points will remain and the oldest point will be removed from the screen. For
example, if the Tail length was set to five points, when the sixth point is received it will be
plotted on the screen and the first point will be removed. All of the points are in the plot
file, but only the tail length points will be seen on the screen.

Show previous buoy positions: The number of pervious buoys positions (previous
calibrations) to be displayed in the Playback window. A 24 hour period is suggested.
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Coded detection threshold (pull-down list): The minimum number of pulses required from a
coded tag in order to consider a position valid enough to be plotted. One buoy must receive
a complete coded pulse train to identify the tag (ID code) but the number of pulses received
by the other two buoys to plot a position may be varied. There are three levels available for
the detection threshold, which are listed in the table below. As the number of tags in a
study increases, the threshold level should increase to reduce false positions. A study
plotted in real time is shown with the Medium threshold level.

Coded Detection Threshold Levels
THRESHOLD NAME REQUIREMENTS
Low Sync + 1 pulse
Medium Sync + 2 pulses
High Sync + 3 pulses

The example shown below was taken from a study with 21 tags that had little movement.
As expected, the best position results occur within the triangle made by the buoys. The
sample on the far left, which is a plot file with a low threshold setting, shows that the
displayed results could be very uncertain. With fewer tags in the water, the results from a
low threshold setting may be less dramatic. The results using medium and high settings are
much cleaner of “flyers” (a single position that implies a tag moved a great distance and
then immediately back again).

MELD IR

NOTE: This is a post-processing function and has no effect on the stored data.
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HELP MENU
Help Topics

Selecting Help Topics under the Help menu will open the help window. The window offers the
options:

Contents

To select a general topic for overall help, use the Contents feature. Open a topic by double
clicking on the book symbol next to the name, or on the name itself. A list of sub-topics will
appear to choose from. Double clicking on one of these sub-topics will open the help topics
related to that general topic.

Index

To select a specific topic, use the Index feature, which will display the complete list of topics in
the help file. To select a topic, either move through the list (using the arrow keys or the scroll
bar) until the desired topic is highlighted, or type the name in the box at the top of the window.
As the name is entered, the list will reflect the letter being entered. For example, if the letter “t”
is entered, the list will alter so the “t” section is shown. Once the topic is highlighted, either
select Display at the bottom of the window, or double click on the topic name.

Find
To search for a specific word within a topic use the Find feature. A word list must be created if
Find has not been previously used. Simply follow the on-screen instructions to setup Find. If
Find is not desired, select Cancel. A list of topics containing the desired word is listed in the
third box from the top. Select a topic and click the Display button at the bottom of the window.

How to Use Help

The How to use help feature provides access to the Windows Help file, which provides step-by-
step directions on using a help file.

About

About provides information about the VRAP software, such as the version number. It also
contains information on how to contact VEMCO Ltd.
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DISPLAY WINDOWS
Chart window

The Chart window displays the locations of the buoys, any received tags, and any waypoints on
the selected background when a study is being run. The background, with the buoys and tags,
can be panned to reposition what is seen in the window. If a gray background is shown, and a
bitmap image was imported, zoom out until the image can be seen and pan until the image is in
the center of the chart and zoom in.

The buoy locations, and if there are lines connecting the buoys, is selected in the Buoys section of
the Project settings window.

The buttons in the top left corner of the window are (from left): Calibrate buoys, Zoom in, Zoom
out, Search for tags, and Stop searching for tags. The Search for tags button (with the
binoculars and tag) will begin a scanning cycle to search for tags enabled in the study. The Stop
searching for tags button (the Search for tags button symbol with a "no" symbol over top) will
stop a previously started scanning cycle.

A legend is shown to the right of the chart, listing the symbols used in the study and the received
tags. The legend button at the top of the window will toggle the legend between scroll and non-
scroll modes, which is especially advantageous when there are more tags than will fit in the
legend. The legend in the window shown below is in scroll mode. The scroll legend will not
print directly from VRAP software (see Print in the File menu).

"™ Chart window M=l

|D:133 Chr:A B3kHz
[D:124, Chi:t, E3kHz
ID:165 Chres B3kHz =]

400 450 =00 =50 GO0 ga0
124328 PM |Lat:44°31.523N Long:063°47.294%  Rieply from : 1081

oo + W aypoints =
& Buoy &
2l & Buop B
-250 & Buop C
280 o Pinger: 6715
o [D:G0000,Chr:D B9.0kHz
-300 m 1 Chtelem; 2222
390 m |[:4000.ChrB.E3.0kHz
m 0236, Chr:C.E9.0kHz
-340 m [[:139,Chra B9.0kHz
_3E0 m |0:147 Chred 69.0kHz
m 0142 Chrd B9.0kHz
-0 T m D143 ChnA B9.0kHz  —
-400 o m D144 Chid £9.0kHz
420 T m 1D:162,Chincd, G9kHz
) -]
-]
a
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The current computer time is displayed in the bottom left corner of the window. Next to the time
is the latitude and longitude matching the current location of the mouse arrow. The right corner
has the status line, displaying the current operation of the software. In the sample window above,
the software is receiving a reply from the buoy SN 1061.

The horizontal axis at the bottom of the background is the X axis, with the zero X value at the
horizontal center of the background. The Y value may be read from the vertical axis, and the
zero Y value is at the vertical center of the background. The grid corresponding with these
axises may be toggled on and off with the Grid button at the top of the Chart window. If the grid
lines are visible then the button looks like a blank piece of white paper. When the grid is off, the
button looks like a grid.

More than one tag may be represented by the same symbol, especially if coded tags are involved
in the study. A tag can be identified in the plot by clicking on the tag symbol with the left mouse
button. This will open the list shown here. Selecting “Tab to Front” in the list

will move the selected tag to the front in the Track history window (see Track :::EK E;:dafw

history in the Display Windows section of this manual). S haw Bath
Hide Both

Shadows zones are three areas around the buoy configuration where the T ab to Front

position calculation of a transmitter will have two solutions (see Introduction

for more details). The VRAP software will assume that the pseudo position El?dc':j"

closest to the last valid position is the correct one and will plot this position in
the Chart window. The shadow positions may be viewed by left clicking on
the desired tag position and selecting from the list (shown here). The options are: Show Primary,
Show Shadow, Show Both, Hide Both, Show All, and Hide All. This may also be accomplished
in the Visibility column of the Track history window.

Create waypoint

A waypoint can only be created while a study is being run, and from within the Chart window.
Click the middle mouse button while the mouse is over the Chart window. The options Add
waypoint and Show all waypoints will appear.

Selecting Add waypoint will turn the mouse arrow to a pointing hand. Click the tip of the index
finger of the hand on the location in the background for the new waypoint. The Waypoint label
window (shown below) will appear for the waypoint's label to be entered. This label will be
shown in the Chart window and in the Waypoints window. If a label is not desired, then press
the Escape (Esc) key on the computer keyboard.

The Show all waypoints option will display all the waypoints in the study, including the ones
whose visibility was removed in the Waypoints window.

Waypoint label

Enter a label far thiz waypoint. [esc for none]

I Boat

()4 Cancel | Help |
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Buoy status

The Buoy Status window, which opens during either a study or a playback, contains the list of
buoys (by serial number) with the date and time of the last communication with the buoy, the
current location (latitude, longitude, X, and Y values), the depth of the buoy's hydrophone (as
assigned during buoy setup), the receiver gain, the number of pulses received by the buoy in the
last upload interval (the time between data uploads from the buoy to the base station, assigned
during tag setup), the noise level, and the voltage level of the buoy's battery (in Volts).

S/ | Dateftime |Lat |L|:|r'|g |>< |"|’ |ﬂ Freq |Eain |F"ulses| Nn:lise| Battem |

1061 § 2002405429 12:40:48 44731 571'N | 063747 502 412.0-258.3 1.0 50.0 54.0 12 21 12,3 walts
1062 | 2002405429 12:40:50 44731 495'N | 063747 405% 525.3 4065 1.0 50.0 450 13 17 [12.0 valts
1063 | 2002/05/29 12:40:51 | 44731 539N 063747 350% BOS.2 -225.9 1.0 (500 51.0 12 13 1271 valts

Tag status

The Tag status window opens during either a study or a playback. The window contains the
current information for each continuous tag that has been setup, including: enabled, tag type,
serial number, frequency, X and Y co-ordinates on bitmap, Z (depth as assigned in tag setup),
latitude, longitude, last update, received data, alignment, and deviation. Each of these are
explained below. The window also displays the frequencies setup for coded tags, but does not
have any additional information because a large variety of tags may be present on that frequency.

The Tag status window shown below has been split in two to allow it to fit on this page.
Enal:uled|Tag type |5N£ID |Freq |>< |Y |z |

v : Pinger 2512 500 51760 -294.10 1.00

rd One charnel telem maan 519.30 -294.60 1.71

v Two channel telem 28300 750 51930 -294.60 1.3
2

cd

....................

Coded200 - B9
Coded200 - I D

Lat Long |Last Lpdate |Data |.-“-‘-.Iign | D |
44737552 | 06347 4200 2001-11-21 16:35:24 Mone 12012
44731.552'MN | 063747 418% 2001-11-21 16:283:56 | 1.303 Depth [m) 14 008

44731.852'N 063747 418%/ 2001-11-21 16:21:56 |31 Temp[*C]: 3.41 Depth [m]
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Enabled: If a check mark is in the Enabled column, the buoys will monitor this frequency. The
Enabled column does not appear in the Playback version of the Tag status window.

Last update: the last time a search was made for this tag. If the continuous tag was not received
at the time of the last search, the location (X, Y, lat and long) and telemetry data (if
applicable) will be removed from the status window.

Align: the number of pulses received by the buoys that can be assumed to originate from the
same tag (the data is in alignment).

Dev: the deviation within the received aligned data.

The frequency that is currently being monitored will be shown highlighted in yellow. In the
window above, the frequency 69kHz is being monitored.

Track history

The Track history window lists the location history of each enabled tag in the study. Each tag is
on a different "page" in the window and is accessed by clicking the tab for the desired tag. The

tabs are colour coded to match the colour representing the tag in the Chart window, and contain
either the tag’s serial number (continuous tags) or ID number (coded tags).

The top of each tag page displays the frequency of the tag, which position algorithm is being
used, the tag type, and the coded channel (for coded tags only). For telemetry tags, the Profile
button on the left will be enabled to allow the telemetry graph to be viewed (see the Telemetry
graph section). When the Visible on Graph is disabled (the check mark is removed), all
reference to this tag is removed from the Chart window. The data is still being received and
recorded but the tag is not visible in the Chart window.

The information shown for a tag includes the visibility, the data and time, the latitude, the
longitude, the shadow latitude, the shadow longitude, the X co-ordinate, the Y co-ordinate, the
shadow X, and the shadow Y, and telemetry data (if applicable). The information at the top of
the list is the most recent position, and the number of positions shown is the same as the tail
length.

s 1111 | ) TSEIEER] [SERIEER) 10155 [ (R (e [N [T

Profile [v “izible on Graph  FrequencylkHz]: I_ Pozition Alg: ITIITIE average Taog Type: IEEE Senzar Channel: IE_

Yizibility| Date Time Lat Long Shad Lat | Shad Long N Shad | Shad 7| Depth [m)| &
Primary | 2002-04-24 07:32:33 44731 627 N| 063747 4277 511.40|-14410 11937 —
Primary | 2002-04-24 07:26:52 | 44731 632'N| 063747 423 508.00|-135.10 11.937
Primary | 2002-04-24 06:42:22 1 44731 B26'N| 063747 4250 513.80|-146.70 11.937
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When the Track history window is copied (see Copy in the Edit menu), only the selected tab will
be copied.

The visibility is what is being shown in the Chart window. The primary position is shown by
default (Primary), but the shadow point, if one exists, may be shown (Shadow). Other options
are to show neither point (Hide both), or both points (Show both). The visibility of the tag's
location at a point in time can be changed by highlighting the visibility for that point in time
(click the square in the chart - see STEP 1 below) and clicking the square again (see STEP 2).
Click the now-visible down-arrow to reveal the options in a pull-down list (see STEP 3). Select
the desired visibility setting and either press Enter or click elsewhere in the window.

STEP 1 STEP 2: | [wisiilty L STEPS:
= Priman :
[ 2 S hadow
: Hide both
Prirnary 2 S haw bath

The shadow values are shown only if the tag was in a shadow zone. The value closest to the
previous plotted position will be considered the valid point and will be plotted in the Chart
window, but the shadow values will be given in the Track history window. If a previous point is
not available, the point closest to a buoy will be used.

Waypoints

The Waypoints window, shown below, lists the time the waypoint was created, its label, the
latitude and longitude of the waypoint, and the X and Y values. The label may be edited by
clicking on a selected waypoint (or a slow double click) and typing the changes. When the

change has been entered, click elsewhere in the window or press the Enter key to make the

change effective in the Chart window.

The Visible check box (on the left) allows the waypoint to become "invisible™ on the Chart
window. The waypoint still exists and can be returned to view by either clicking the Visible box
again, or by clicking the middle button on the mouse (while the mouse is over the Chart window)
and selecting the Show all waypoints option. The sample Waypoints window below indicates
that the "Boat" waypoint is visible in the Chart window, but the "Flock of birds" waypoint is not
visible.

W/ appoints =] E3
Wizible |Time |La|:ue| |Latituu:|e |L|:|ngitude |>< |Y

£ 2002/05/2312:30:07 Flack of birds 44731 520N | 0B3°47 332%/ | B27 B0 |-358.73
F ........... f 2002/05/2912:30:46 | Boat 44731 510N (063747 512%/ | 39916 |-378.23
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Study notes

The Study notes window allows notes to be entered as the study progresses. These notes can be
read during a playback, and can be printed or copied during either a study or a playback.

To enter notes, click the third button at the top of the window (with a "bubble” symbol). A line
will appear next to the button (see picture below and on left) with a cursor. Type the note in the
line and press Enter. The note will appear with the date and time the note was entered, as shown
in the picture below and on the right. Notes may be written only during a study, but may be
viewed during either a study or a playback.

™= Study notes M=l E3 " Study notes M=] E3
@lllaeginningm rain. | @lll

2001-11-21 15:17:40 Beginning to rain.

Telemetry graph

The data from a telemetry tag can be viewed in graphical form, as shown below. This is
accomplished by clicking the Profile button in the Track history window.

The graph can be repositioned with the pan feature. This is performed by clicking the right
mouse button on the graph and dragging the mouse without releasing the mouse button. When
the graph is in the desired location, release the mouse button.

A section of the graph may be zoomed in on by clicking the graph with the left mouse button and
dragging the mouse down and to the right (encircle the desired area with the box formed) before

releasing the mouse button. Zoom out by clicking the left mouse button on any part of the graph
and move the mouse up and to the left before releasing the mouse button.

For two channel telemetry tags, the data from channel one is shown in red with the left vertical
axis and the data from channel two is shown in blue with the right vertical axis.

== | Ch telem: 2523 _ (O] x|

|
114
1.2
E1af
14
=154
16|
17
151
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Playback window

The Playback window is essentially the Chart window while a playback file is being viewed. In
appearance, the Playback window is very similar to the Chart window, with only the buttons
along the top of the window being changed. These buttons are (from left to right): Play, Stop,
Continuous play, Pause, Rewind, Eject - load new file, Zoom In, Zoom Out, Legend, and Grid.
The speed of playback can be controlled by sliding the Speed bar closer to either Fast or Slow.
The amount of the playback viewed is indicated as a percentage in the Progress bar in the top

right section of the window.

The latitude and longitude values at the bottom of the window indicate the location of the mouse
arrow when it is pointing within the window. The date and time of this moment in the original

study are shown in the bottom left corner of the window.

= Study playback: C:AVYEMCOAYRAPAYemcol\WRAPS 2002-05-31.002
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-2
50 £F
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Waypoints

Buaoy A

Buoy B

Buoy C

Pinger: 1111

1 Ch telern: 2222
ID:133.Chrcds B3kHz
10:138.Chrcds B3kHz
ID: 165, Chica B3kHz
ID:142 Chica B9kHz
10136, Chicé B3kHz
10:1 . Chrcd B0kHz
ID:137 . Chicds B3kHz
ID:141 Chrcds B3kHz
ID:162, Chics B3kHz
ID: 146, Chica B3kHz
I0:134 Chica B9k Hz
ID:144 Chicd B3kHz

F
—

| |

If any changes have been made to a plot file during a playback, a prompt will appear when the

plot file is closed pertaining to saving the changes.
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APPENDIX
CALIBRATIONS (using software)
Buoys

The buoys may need to be calibrated if their position is believed to have changed, or if a new
project is being setup. A change in position may be caused by tidal or wave action.

The position of the buoys may be automatically calibrated during a study according to the
Calibration interval value assigned in the Project settings window.

A manual calibration can be requested while a study is being run from within the Chart window,
or when a study is not being run by selecting Buoys in the Calibrate option within the Tools
menu.

When the buoys are calibrated from the Tools menu, the Buoy calibration window opens (shown
below) and the buoys appear on the chart. If the buoys are shown in their approximate locations,
then click the Calibrate Buoys button within this window (top left corner, with an icon of three
buoys) and the calibration cycle will begin. If the buoys are not shown in their correct positions
(approximately), then move the buoys manually until they are close to their actual positions and
click the Calibrate Buoys button. This usually occurs when GPS data is not available or is not
correct.

To manually move the buoys in the chart, left-click the desired buoy once and release the mouse
button. That buoy is now connected to the mouse arrow and will move with the mouse. Position
the buoy over the desired area and left-click the mouse again. The buoy is now “dropped” in its

new location. Repeat this with the other buoys until all are approximately in place.

"™ Buoy calibration H=] B3

_200 & Buoy &
& Buoy B
=250 & Buoy ©

_300 e
380
400

-450)

Lat: 44°31,633N Long: D63°47. 322"
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The cycle of calibration events are:

N =

5.

6.

Buoy A is instructed by the base station to activate its local pinger, which operates at 34kHz.
The base station instructs Buoy B and Buoy C to receive at 34kHz and record incoming data.
After an elapsed period of time, Buoy A is instructed to deactivate its local pinger and
transmit its data to the base station. Buoy B and Buoy C are instructed to transmit the data
pertaining to the signals received from Buoy A.

Steps 1-3 are repeated with Buoy B transmitting an acoustic signal from its local pinger and
Buoy A and Buoy C listening.

Steps 1-3 are repeated with Buoy C transmitting an acoustic signal from its local pinger and
Buoy A and Buoy B listening.

The position of each buoy is calculated.

The status bar at the bottom of the window will display the action and result at each step of the
calibration procedure.

Speed of Sound

The exact speed of sound in water is actually a function of the environmental conditions in the
water (such as salinity and temperature), and may be calibrated for the project area by using the
buoys. How often the speed of sound should be calibrated depends on how rapidly the
environmental conditions are changing. The speed of sound can not be calibrated while a study
is being run.

* The distances between the buoys MUST be accurately measured in meters. *

To calibrate the speed of sound by using the buoys, follow the steps listed below:

1.

2.

Secure the buoys in the locations being used in the study (see Buoy Mooring in the
appropriate Hardware manual).

Enter the buoy information (serial number, etc.) in the Buoy section of the Project settings
window (see Edit menu in Software section).

In the Project section of the Project settings window, click the arrow to the left of the
Calibrated box or select Speed of sound under the Calibrate section of the Tools menu. The
Calibration window will open (shown on next page) with the buoys A, B, and C identified
on the left side of the window.

Enter the distances between the buoys (in meters) in the boxes on the right side of the
window. It is important that the correct distances are entered in the correct boxes (the
distance between Buoy A and Buoy B is entered in the box "Distance from A to B").
Click the Calibrate button (with the picture of a buoy on it). The buoys will communicate
with each other and calculate the average speed of sound. This value will show in the
Average speed of sound box at the bottom of the window and will be transferred to the
Project settings window when the OK button in the Calibration window is selected.

VEMCO - VRAP5 SOFTWARE MANUAL - PAGE 37



"= Cahbration =]

Buopd 3122 Diiztance from & to B ||

Buop B 3120 Diztance from B to C

Buop C 9121 Diztance from C to & I

~Sound calibration dats :
At At 8 Calibrate
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x Cancel
Average zpeed of zound I ? Help

| i

This option is accessible from either the Calibrate option in the Tools menu, or from the Project
page of the Project settings window (in the Edit menu).

Background Image

The Calibrate background window (shown below) allows the background bitmap to be tied to
the actual location by entering measured latitude and longitude values, and is opened by either
selecting Calibrate in the GIS settings window (see Project section of Project settings in the Edit
menu) or by selecting Background image in the Calibrate section of the Tools menu. It is best to
measure the latitude and longitude of at least three reference points that are easy to identify on
the bitmap. Two of these points should be in opposing corners (either top left and bottom right,
or bottom left and top right), and as close to the corner as possible.

The positioning data is entered into the VRAP software by following the steps outlined below
(after the Calibrate background window is open):

1. Click the Active box in the Reference point A section to activate the first reference point.

2. Verify that the Track mouse option has been selected (should be automatically selected).

3. Use the scroll bars to show the general area of the reference point in the left side of the
window.

4. Move the mouse over the bitmap in the left half of the window until the tip of the mouse
arrow is as close to the reference point as possible. Note that the bitmap on the right
changes as the mouse arrow moves. This is an exploded view of the area the mouse is
currently pointing to. The X and Y values also change to reflect the location of the mouse
arrow.

5. Click the left mouse button. The X and Y values will be set as those to which the mouse
arrow was pointing. If this is satisfactory, then proceed to Step 7.

6. Click the same Active box again (it was disabled when the reference point was selected) and
use the blue positioning arrows to move the reference point pixel by pixel. The X and Y
values will change as the cross hairs in the right bitmap moves.

7. Enter the measured latitude value in the Lat box, including the N or S for North or South.
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10.
11.

12.

Enter the measured longitude value in the Long box, including the E or W for East or West.
Repeat steps 1 - 8 for the second reference point, found in the Reference point B section.
Select the Calibrate button.

Point mouse arrow on a location in the bitmap for which the latitude and longitude are
known and verify that the values shown to the left of the blue arrows are correct. The
picture below illustrates this step.

Select OK to accept the calibration and close the window. This will return you to the
Project settings window.

= Calibrate background M=l

—Feference point & —Reference point B

[~ Active [T Active

o [rmonn |||, e
Long Im Long Im
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VEMCO - VRAP5 SOFTWARE MANUAL - PAGE 39



CODED CHANNELS

The VRG60 receiver can identify up to four transmitter types on one frequency. This is done by
using different sync and bin values for each of the four channels. The assigning of these sync
and bin values is referred to as a coded map. The default coded map (referred to as Default
Coded Map “D”) is shown in the table below. The channel values differ depending on the
frequency range so as to best fit the transmitter capabilities based on transmitter size and power.

VEMCO Default Coded Map “D”
Transmitter | Frequency Band Channel Code Type
Model (kHz) # Sync Bin Description | Transmitter
(ms) (ms) Abbr.
A 401.2 22.3 256 Pinger R256
V8, V8B, 51 - 78 kHz :
V8SC, V16, (Blank = 300) B 380 20 4K Pinger R0O4K
V16T, V16P C 360 20 256 Sensor S256
D 340 20 64K Pinger R64K
A 800 30 256 Pinger R256
V22, 34.1-50.5 kHz .
V22T, (Blank = 650) B 770 30 4K Pinger R0O4K
V22pP C 740 30 256 Sensor S256
D 710 30 64K Pinger R64K
A 1000 40 256 Pinger R256
V32, V32T, 27 - 34 kHz .
V32P. Chat (Blank = 750) B 960 40 4K Pinger R0O4K
C 920 40 256 Sensor S256
D 880 40 64K Pinger R64K

If a VRAP system that has been setup with a default coded map receives a pulse of 401.2
milliseconds then it knows that the bin should be 22.3 milliseconds (ms) and that the ping
originated from a 256 pinger type transmitter. A 256 pinger type transmitter with a sync of 380
ms and a bin of 20 ms will not be identified unless the coded map is customized in the Channel
settings section of the frequency page in the Coded tags section of the Project settings window.
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CODED TRANSMITTER TYPES

The VRAP receiver is capable of receiving transmissions from the coded tags types explained
below. Once a transmitter is powered, it will continue to broadcast according to factory setup
until powered down.

256 Pinger

The coded 256 Pinger emits a pulse train consisting of six pulses, usually followed with either a
fixed or random delay period. Each pinger will have one of 256 unique codes. The unique code,
coupled with a random delay, allows a study to have up to 256 pingers operating on the same
frequency at one time.

4K Pinger

For applications where more than 256 pingers are deployed at a single time, coded pingers with
4096 unique codes are available. The 4K Pinger emits a pulse train consisting of seven pulses
and either a fixed or random delay period. A study can have up to 4096 pingers on the same
frequency at the same time.

64K Pinger

For applications where more than 4096 pingers are deployed at a single time, coded pingers with
65536 unique codes are available. The 64K Pinger emits a pulse train consisting of eight pulses
and either a fixed or random delay period. A study can have up to 65536 pingers on the same
frequency at the same time.

256 Sensor

Coded telemetry transmitters are capable of transmitting either temperature or depth data within
the pulse train. The 256 Sensor transmitters emits a pulse train consisting of eight pulses. A
study may contain up to 256 coded telemetry transmitters on the same frequency and at the same
time.

The ID number, slope, intercept, and data units of each transmitter being used must be entered

using the Telemetry transmitters feature in the Setup menu for correct interpretation of the
telemetry data.
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GLOSSARY

Background Image - the bitmap used for the background in the Chart window during a study.
This bitmap is imported into the VRAP software in the Preview page (tab) of the Background
image section in the Project setup. The bitmap may be calibrated using latitude and longitude
information (see Calibrations section of Appendix).

Blanking interval - the length of time after a valid pulse has been detected during which no
further pulses can be detected. This is to prevent the receiver from double triggering on echoes.
The blanking interval is normally set to less than 50% of the minimum transmitter period. Care
must be taken when changing this value. If the interval is too short, false triggering will become
a problem. If the interval is too long, data pulses may be missed.

Calibrate buoys - When the Calibrate buoys box has a checkmark in it, the buoys will be
automatically calibrated according to the time entered in the Calibration interval box. If the
box is not checked then the buoys will not be automatically calibrated and the Calibration
interval value shown is ignored.

Calibration interval - the time, in minutes, between automatic buoy position calibrations. The
time value used depends on the conditions in which the buoys are operating. A calibration may
be forced before the specified time has elapsed. This may be done by selecting Buoys in the
Calibrate option of the Tools menu, or by clicking the Calibrate button in the Chart window.

Connect buoys with lines - Selecting the Connect buoys with lines option (checkmark in box) will
connect the buoys shown in the Chart window with three lines. This aids in identifying the
study area within the buoys.

Deviation - refers to the standard deviation between pulses in a set of aligned data.

Fast Track - An average time is compiled and used with Pulses to avg to determine the best data
times. The position is calculated for each of these best data times and all positions are plotted
on the chart.

Panning the graph - The graph can be repositioned with the pan feature. This is performed by
clicking the right mouse button on the graph and dragging the mouse without releasing the
mouse button. When the graph is in the desired location, release the mouse button.

Pinger - tags that emit an acoustic signal at a fixed period and frequency. They are used for
locating and tracking purposes and transmit no depth or temperature information. Once a pinger
is powered, it will broadcast its signal according to the factory setup until powered down. It is
possible to have pingers with a delay start and/or cycle on/off times.

Position Average - All positions are calculated. An average position is complied from the

positions and used with Pulses to avg to determine the best data positions. A new average is
taken of these best data positions and the single position is plotted on the chart.
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Positions to show - the number of pervious buoys positions (previous calibrations) to be displayed
on the Chart window. This value is entered in the Positions to show box in the Buoy page of the
Project settings window (see Edit menu).

Project - the geographical setup of the buoys and the information pertaining to those buoys and to
the tags used in the area. After a project is setup (in the Project setting section of the Edit
menu), any number of studies may be run using the project's settings.

Scanning cycle - The buoy receivers listen to only one frequency at a time. To use tags on more
than one frequency during a study, the buoys cycle through frequencies and listen for each
Enabled tag (see the Tags page of the Project settings window in the Edit menu) listed.

Scanning cycle delay - the length of time, in minutes, the buoys will wait between scanning cycles.
This feature is used to conserve buoy battery life. The value is set in the Buoy page of the
Project settings window (see Edit menu).

Shadows zones - three areas around the buoy configuration where the position calculation of a
transmitter will have two solutions. The locations of these areas depends on if the buoy
hydrophones and the received signal are on the same plane or not. For more detail, see the
Theory of Operation portion of the Introduction section in this manual.

Study - the collection and storage of data, such as tag positions and times. Data received during a
study is automatically stored to a database.

Sync (2 channel tags) - a value (in milliseconds) that allows a receiver to correctly receive the data
for a two-channel transmitter. The value is currently factory set at 1150ms and must be entered
as such in the VRAP software (see the Tag page of the Project settings window in the Edit
menu).

Tag - term used to refer to all acoustic transmitter types. It is derived from the term “fish tag”.

Tag types - three types of tags are available: pinger (transmits a ping at a constant interval, or
period), one channel telemetry (transmits either temperature or depth telemetry data), and two
channel telemetry (transmits both temperature and depth telemetry data).

Telemetry transmitters - either one or two channel devices transmitting information at a fixed
frequency. The types of information transmitted are temperature and/or pressure. These
transmitters are capable of transmission only. Once a transmitter is powered, it will continue to
broadcast according to factory setup until powered down.

Time Average - An average time is compiled and used with Pulses to avg to determine the best
data times. A new average is taken from these best data times and a position is calculated. This
single position from the new average is plotted on the chart.

Waypoint - a location of significance or interest that can be recorded within a study. The location
is marked with a red circle and may have an optional label. The waypoint may be viewed
during playback of the study.
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Add, 16
Delete, 17
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Coded tags
Algorithm, 21
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Default Colour, 19
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19
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Tail length, 20
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Upload interval, 17
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Delete tag, 13
Edit tag, 13
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Sensor type, 15
Tag parameters, 13
Tail length, 14
Telemetry data, 15
Upload interval, 13
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Chart, 29
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Study notes, 34
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Track history, 32
Waypoint, 33
Edit menu
Copy, 5
Exit, 5
Project settings, 5
File menu, 3
Close, 3
Exit, 4
New, 3
Open, 3
Page Setup, 4
Print, 4
Reopen, 3
Save As, 3
Help menu, 28
About, 28
How to use help, 28

Help topics
Contents, 28
Find, 28
Index, 28
Last rollover, 23
Plot file
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Custom settings, 26
Naming, 25
Viewing, 24
Print, 4
Page setup, 4
Project
Background image, 7
Close, 3
Exit, 4
Force inverted data axis, 6
New, 3
Open, 3
Reopen, 3
Save As, 3
Time axis range, 6
Project settings, 5
Background image, 7
Base station, 5
Buoy setup, 11
Buoys, 11
Coded tags, 16
Com port, 5
Continuous tags, 12
Failure delay, 5
Project, 5
Radio retries, 5
Speed of sound, 6
Telemetry data profile, 6
Shadow zones
View, 30
Software
Installation, 2
Laptop use, 2
Requirements, 2
Speed of sound
Calibrate, 37
Default, 6
Study menu, 24
Build plot file, 25
Playback, 24
Start, 24
Stop, 24
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Stop playback, 25
System requirements, 2
Telemetry graph

Force inverted data axis,

6

Set time axis range, 6

Viewing, 34
Testing

Communication, 23
Tools menu, 22

Calibrate, 22

Sleep, 23

Test communications, 23
View menu, 22

Buoy distances, 22

Zoom in, 22

Zoom out, 22
Waypoints

Add, 30

Display, 30

Visable, 33

Window, 33
Window menu, 21

Arrange icons, 22

Cascade, 21

Tile, 21
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